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LIBRARY DISSERTATION TEMPLATE USAGE GUIDE

1) On the SHSU homepage, go to Graduate Studies.  Click on “Forms and Publications,” then double click on “Thesis/Dissertation Template” to open it.  
2) This template uses macros. If you receive a warning when opening the document that macros have been disabled, you can enable the content by clicking on the security warning and click Enable Content on the yellow ribbon across the screen if it appears.
[image: ]


3) A welcome box will pop up with instructions.  After reading these instructions, you can close the welcome box.  Using the SHSU Thesis tab, click on Welcome Message next to the smiley face icon anytime to see the welcome box again.
[image: ]


[image: ]Before proceeding any further, save the template to your computer as a Word Macro Enabled Document (.docm) by clicking on File / Save As (rename as—last name_1st initial.docm—not a docx document)
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4) You will use the SHSU Thesis tab (next to the Home tab) for most of your actions in the template. Note: hover your mouse over the items in the SHSU Thesis tab for an explanation of each item’s function. Show hidden formatting by going to the SHSU Thesis tab and clicking on the paragraph marker in the top left corner.
[image: ]

5) You can find the Style ribbon by clicking on the Home tab; the Style ribbon is on the right running across the top of the screen. If you are transferring or manually entering content, the Style ribbon allows you to apply different styles to this content.
[image: ]

6) Open Navigation Pane: Click on the SHSU Thesis tab and then Navigation Pane. Note: To delete pages you will not use, right click and select Delete in the Navigation Pane; you cannot press the Delete key on the keyboard to delete a page.  
[image: ]

To begin, scroll down to the Abstract page. Remember, DO NOT type over black text in the template (per the Welcome Message); only type over blue or orange text. Fill in the following fields on the Abstract: Title, Thesis/Dissertation, College/Department, Degree Title, Name, Grad Month/Year.  [image: ]
After you complete the fields in the Abstract page, automatically update this information on the Title page by clicking Update All in the SHSU Thesis tab on the left hand side.  You will see that the information about your document is now populated on the title page.


[image: ]



7) [image: ]Scroll to the Committee Signature or Approval page. To fill in fields on the Approval Page: place the cursor beneath the APPROVED block and click. 
[image: ]
You will see that there is a Committee Structure text box here. 


Click on the down arrow to choose one of the Committee Structure settings.  When you click on a setting, the template will automatically create fields for you to enter information. 



After the text box populates, input the name of your dissertation director and select Thesis or Dissertation beneath the signature block.
[image: ]

Note: If you need to reset the Appellation field, click on the Committee Structure text box, click the pull down arrow, and reselect the committee structure. 



8)  DEDICATION: Scroll to or select DEDICATION on the navigation pane. Copy and paste content over the yellow text. (or if you are not using the dedication page, use the Navigation Pane to delete the unused page: right click, choose delete).

[image: ]



9) ABSTRACT: Scroll or select ABSTRACT on the navigation pane.  You should have already filled in this information (see step #7 in this guide), but if you have not, complete the following—Last Name, First Name, Title, Degree Title, Department, Grad Month/Year 

[image: ]

-Copy and paste content from your original document into the Abstract text field.  The Abstract must be no more than 350 words in length.
-Keywords: Copy and paste content from your original document into the keywords textbox.  Enter keywords, capitalizing the first word of each phrase and all proper nouns. [image: ]

ACKNOWLEDGEMENTS: Scroll to or select ACKNOWLEDGEMENTS on the navigation pane.  Copy and paste content from your original document into the Acknowledgements text box (or use the Navigation Pane to delete the unused page: right click, choose delete).

[image: ]

10) PREFACE: Scroll to or select PREFACE on the navigation pane. Copy and paste content from your original document into the PREFACE text box (or use Navigation Pane to delete unused page: right click, choose delete).
[image: ]

Scroll to or select TABLE OF CONTENTS from the Navigation pane. 
[image: ]

CAUTION: Do not manually edit the TOC, the LIST OF TABLES (LOT), or the LIST OF FIGURES (LOF) for they will automatically populate. Once you have typed the contents of a chapter and added the appropriate headers into the template as instructed in this guide, be sure to update the TOC/LOT/LOF by clicking on Update All in the SHSU Thesis tab (left corner). 

Note: the front matter, chapters, appendices, and vita are hyperlinked in the TOC. Once your TOC populates, to navigate elsewhere in the dissertation (for example, Chapter 3), you can use the navigation pane or go to the TOC, and hold down the Ctrl key while clicking the mouse on the title of the chapter to which you want to navigate. 

It is a best practice to click inside the TOC and click UPDATE ALL in the SHSU Thesis tab after each chapter you complete in order to update the header titles and page numbers). 



11) ADDING CHAPTER 1: Use the navigation pane to navigate to the Title of Chapter I.  The proper heading style is already provided; click the text box to insert a 1st level heading.[image: ]
Note: At any time, you can hover over the Headings selections in the SHSU Thesis tab to see tips or instructions about adding your header to the chapter.
[image: ]

After entering your title, you will notice that your new title now appears in the navigation pane.

Note: Sometimes, in your original document, you may have accidentally indented a paragraph twice instead of once. To correct this issue, before copying it, highlight the content, then press Ctrl+h. The Find/Replace feature should appear. In the Find what field, press Shift+6 and type the lowercase letter “t”. This will allow you to locate each double indent. Leave the Replace with field blank. Select the Replace All button and the double indents should disappear from the original document, leaving you with paragraphs that have only been indented once. Then copy and paste the content into the template. 
Note:  INSERTING COPIED HEADERS: Do not copy and paste your headers from another document into the template.  The template will not update these unless you then go into the SHSU Thesis tab and apply the appropriate style to each subheading.  It is a best practice to copy only text over (or type it directly in), not headers, into the template for this reason. 
However, if you choose to copy and paste your headers, you will need to apply a heading level style to the transferred heading titles.  Click on the header in the new document and use the SHSU Thesis tab to apply the new header style.
[image: ]

The navigation pane will automatically update with each subheading you add, but you will need to go to the SHSU Thesis tab and select Update All for the TOC to update.
[image: ]

CAUTION: At this time, only copy and paste content. Copy and paste ALL content in Chapter I before moving to Chapter II.
Copy and paste content incrementally (moving between headers). In other words, copy and paste one section (or group of paragraphs) at a time, then type the next header, then paste in the content, and so on. To make sure that you are not pasting paragraphs into subheading text boxes, click outside each subheader text box after you type the title into the box.
[image: ] 
BUILDING TABLES OR FIGURES:  Note: Please build your tables in the template.  -DO NOT copy and paste entire tables. You will need to manually build the tables into the template.  Do not copy them over from another document, as they may not behave as expected and the TOC will not update accordingly. 




To build tables, use the SHSU Thesis tab: Put your cursor where you want to insert the table in the document. Click on 5x7 Table in the SHSU Thesis tab for a standard table.  You can also click on Custom Table in the SHSU Thesis tab to designate the number of rows/columns desired.  

[image: ]


When you insert a table, you will automatically be given a text box to enter the table title.
[image: ]

Be sure to click on UPDATE ALL on the SHSU Thesis tab to add your table title to the LOT.

[image: ]
Note: If you make a mistake on your title after you have created it, you will need to correct it as follows: To change the title of your table, you will need to right click on the table title while inside the LOT to update the individual title.  Click on Update Field to correct the title in the LOT.
[image: ]

[image: ]


[image: ]
ADDING FIGURES: You will use the same process to add figures to your chapter, only you will click on New Figure in the SHSU Thesis tab to insert the figure. You will automatically be given a text box to type the figure caption. 

[image: ]
Type the figure caption in the figure caption text box. Update the document by clicking on the SHSU Thesis tab and selecting Update All. 

-LANDSCAPE table: To Add a Landscape Table: 
Note: To create a landscape table, you must first place it on a Landscape page:  Place your cursor where you want to add the page. Click Landscape Page on the right hand side of the SHSU Thesis tab.  The template will automatically add a landscape page with the correct page number format.
[image: ]
Then, select either Custom Table or 5x7 Table in the SHSU Thesis tab to insert a table as before.
[image: ]

-CONTINUED TABLES: For Tables that exceed one page (split tables):  Place your cursor in the last row of the page, then click on Table (continued) on the SHSU thesis tab. 
(Note: the default table format is set to carry over table headers)
[image: ]
12) LIST OF TABLES (LOT): Remember, this will automatically populate (please, update chapter by chapter: place cursor in the LOT, click on Update All in the SHSU Thesis tab to update titles and page numbers).  The LOT will hyperlink to the caption you create for each table (see Item 17 below for instructions on creating table and figure cross-references).  

13) LIST OF FIGURES: Remember, this will automatically populate (please, update chapter by chapter: place cursor in the LOF, click on Update All in the SHSU Thesis tab to update titles and page numbers). 
Note: as in the TOC and LOT, figures are hyperlinked in the LOF. (See below for instructions on creating table and figure cross-references). 

14) ADD CROSS REFERENCES (also called Call-outs): (Note: Please, be aware that Tables must be built prior to the addition of a Cross-reference).  Remember to provide a cross reference for all tables and figures mentioned in text.  To create a cross reference, click on the text before the point where you would like to create your reference in the text (this process will insert the words “Table [N]” or “Figure [N]” in this spot, where [N] is the number of the table or figure being inserted).  Then click on either Table Call Out or Figure Call Out in the SHSU Thesis tab to insert the appropriate cross-reference.  
[image: ]
15) After clicking on Table Call Out/Figure Call Out, choose Reference Type (table, figure, etc.); choose Title of Reference from the options in the white box; in the “Insert Reference To” drop-down, choose “only label and number”; click insert and close.  (Note: This series will need to be completed for each Table/Figure/Illustration cross-referenced in the text)
[image: ]

[image: ]
	Comment by Stoner, Haley: I have revised the wording in this step to clarify the process; it has worked for me in the template.  
16) NEW CHAPTERS: You can add the next chapters by clicking on New Chapter in the SHSU Thesis tab, then copying and pasting content from your original document as described above. Remember it is a best practice not to copy and paste headers, but instead to create them in the new document and paste the content in between. Continue until all chapters of the dissertation have been completed.  



17) REFERENCES: See instructions on the reference page in the template; you may either copy and paste references manually from your original document or use the References tab.  Please follow the structure from your chosen style guide.
[image: ]
18) [image: ]Add APPENDICES as needed: Go to the Navigation Pane on the SHSU Thesis tab.  Right click on Appendix A in the Navigation Pane and select New Heading After.  Repeat as necessary to add more appendices.  Then copy and paste in the content from your original document.



19) [bookmark: _GoBack]VITA: Go to the Navigation Pane on the SHSU Thesis tab.  In the text box, you have two choices.  You can type content into the text box, or copy content from another document and under Paste Options on the Home tab, select “Keep Source Formatting.”

[image: ]

That’s it! Just be sure to save frequently and use the SHSU Thesis tab to update your page numbers and titles as you work through your document. If you need assistance with the template format, you can contact The Writing Center at the SAM Center. They have tutors who can advise you on many issues regarding the template.
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